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NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
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Welcome to WeatherLink®
The data logger and WeatherLink® software let you connect a Davis Vantage 
Pro®, Vantage Pro2™ console, or Weather Envoy™ to your personal computer so 
you can store, view, plot, analyze, export, and print weather data collected by the 
weather station.

Contents of Package
The WeatherLink software is available with three connection types, USB, 
WeatherLinkIP, and serial. There are also multiple versions of the serial data 
logger. Verify which data logger you have.
WeatherLink With USB Connection (# 6510USB)

The WeatherLink package with the USB connection contains the following:
• Data logger with USB mini-connector
• 8' (2.4 m) USB Mini-B connector cable
• WeatherLink Software CD
WeatherLinkIP (# 6555)

WeatherLinkIP is a simple way to post data from your console or Envoy directly 
to the Internet.
The WeatherLinkIP package contains the following:
• WeatherLinkIP data logger
•  5' (1.5 m) Ethernet cable
• WeatherLink Software CD
WeatherLink with Serial Port Connection (# 6510SER)

The WeatherLink package with the serial connection contains the following:
• Data logger with serial connector
• 8' (2.4 m) cable with connector
• 9-pin (DB-9) PC COM Port Adapter — Use the 9-pin adapter to connect the 

data logger to a 9-pin serial port. 
• Loopback connector — The loopback connector is a short piece of cable with 

a phone plug at one end and a red plastic cap at the other. The loopback con-
nector can be used to determine what serial ports are available for the data 
logger and for troubleshooting serial communications problems.

• WeatherLink Software CD
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Computer Requirements
Optional Accessories for Serial Port Connection
The following optional accessories, designed for use with WeatherLink for 
Serial, are available from your dealer or may be ordered directly from Davis.
• Telephone Modem Adapter — For data transmission from the data logger 

using a modem
• Straight Through 4-Conductor Extension Cable — For more flexibility in 

placing your console, add one 40' (12 m) extension cable to extend the 
distance between your station and the computer (48' (14.4 m) maximum).

WeatherLink for APRS (# 6540)

WeatherLink for APRS gives you the ability to connect WeatherLink to your 
ham radio. The WeatherLink for APRS package has the same contents as 
WeatherLink with Serial plus:
• 25-pin TNC modem connector
WeatherLink for Alarm Output (# 6544)

WeatherLink for Alarm Output gives you the ability to set alarms that turn 
devices, such as heaters and fans on and off. The WeatherLink for Alarm 
Output package has the same contents as WeatherLink with Serial plus:
• Alarm Output data logger with connector block
WeatherLink for Emergency Response (# 6550)

WeatherLink for Emergency Response connects the WeatherLink software to 
CAMEO® Aloha software. The WeatherLink for Emergency Response 
package has the same contents as WeatherLink with Serial plus:
• Emergency Response streaming data logger
WeatherLink for Irrigation Control (# 6560)

WeatherLink for Irrigation Control uses your weather station to turn your irri-
gation system on or off. The WeatherLink for Irrigation Control package has 
the same contents as WeatherLink with Serial plus:
• Irrigation Control data logger with connector block

Computer Requirements
WeatherLink software is compatible with computers running various 
Windows platforms. WeatherLink with serial connection is compatible with 
computers running the following platforms: 98, 98SE, ME, 2000, XP, or Vista. 
WeatherLink with a USB connection is compatible with computers running 
the following platforms: 98SE, 2000, XP, or Vista.
WeatherLinkIP is compatible with computers running the following platforms: 
98SE, ME, 2000, XP, or Vista.

Note: WeatherLink is not compatible with the 64-bit versions of Windows.
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Software Installation
The amount of space necessary for the data files depends on the archive 
interval. Database files containing data stored at a 30-minute archive interval 
require approximately 36K of disk space per month of data. The file size 
grows depending on the archive interval. For example, data stored at a 
1-minute interval requires approximately 1 MB/month while the data stored at 
a 2-hour interval requires approximately 9K/month.
Other requirements include:
• Windows-Compatible Display — High (16-bit) color setting 

recommended
USB Hardware requirements
• One free USB port.
WeatherLinkIP Hardware requirements
• Broadband Router or switch with one free port.
• An “Always-on” connection to the Internet — A high speed DSL or cable 

internet connection that maintains constant connection to the internet.
Serial Port Connection Hardware Requirements
Listed below are the hardware requirements for creating a local connection 
and a remote connection.

Local Connection Hardware Requirements
• One free serial port.

Remote Modem Connection Hardware Requirements
In addition to the provided hardware and the computer equipment listed above, 
the following hardware is required for a remote modem connection:
• One external modem to connect to the data logger — The modem must 

be Hayes®-compatible and run at 1200, 2400, 4800, 9600, 14400, or 19200 
Baud Rate.

• One internal or external modem connected to your computer — The 
modem must be Hayes®-compatible and run at 1200, 2400, 4800, 9600, 
14400, or 19200 Baud Rate.

• Telephone Modem Adapter — The Telephone Modem Adapter (#6533) 
provides the connection between the data logger and the modem.

Software Installation 
Follow the steps below to install the WeatherLink software. 
1. Place the WeatherLink software CD in your CD ROM drive.

The install program should start automatically. If the install program does 
not start, select Run from the Start menu, type D:\SETUP (or the correct 
letter for your CD ROM drive), and click OK to begin the installation.
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Software Installation
A series of dialog boxes display, prompting you to complete the 
WeatherLink installation. The WeatherLink Setup for .NET Framework 
dialog box may display.

WeatherLink 5.8 requires the Microsoft .NET Framework 2.0 to operate. If 
your computer does not have it installed, the above dialog box displays. 

2. Click Accept to install the necessary components.
The License Agreement dialog box displays.
4



USB Hardware Installation
3. Review the license agreement, click I agree and click Next. The Choose 
Destination Location dialog box displays.

4. Select the default location to install WeatherLink or find another location 
by clicking Browse. 

Note: If you are upgrading your software from a previous version, click Browse to search for 
the directory or folder of the previous version of WeatherLink. 

5. Click Next once you have selected a location. The Confirm Installation 
dialog box displays. 

6. Click Next to start the installation. The Installing WeatherLink dialog 
box displays the installation progress. The Installation Successful dialog 
box displays once the software installation has been completed.

Note: During the installation process, the USBXPress Device Driver and the Bridge Driver, two 
drivers required for USB connections are installed automatically.

7. Click OK. WeatherLink has been installed successfully.

USB Hardware Installation
Complete the local USB hardware installation by using the instructions below:
1. Locate the console or Weather Envoy that will receive the WeatherLink 

USB connection.
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USB Hardware Installation
2. For consoles only: Enter the console’s Setup Mode by pressing and hold-
ing DONE, then pressing the down arrow (-). Entering Setup Mode 
ensures that the station is not writing any data and saves the current daily 
weather information to memory.

3. Remove the battery cover, the batteries, and AC-power adapter, if present.

Note: Failure to remove power to the console or Envoy before installing the data logger may 
cause damage to the data logger or console. Plugging or unplugging the data logger 
while power is applied can lock up or damage the data logger.

4. Firmly insert the USB data logger into the large receptacle marked 
EXPANSION inside the battery compartment. 

5. Locate a free USB port on your computer and connect the USB connector 
to the port.

6. Insert the USB - Mini B connector on the USB connector of the USB data 
logger. The connection between the console and the computer can be 
extended up to 16' (5 m) using a USB-to-USB connector cable.

USB Port

Vantage Pro or 
Pro2 Console

Weather
Envoy

Data
Logger

USB Mini-B
Cable

USB-A
6



USB Hardware Installation
Note: Do not attempt to use more than a 16' extension cable, or the data logger may have diffi-
culty communicating with the computer.

7. Reconnect the AC adapter, if present and then reinsert the batteries.
The console beeps three times; each beep occurring within one second of 
the others. Once power has been returned to the console, the Setup Mode is 
automatically displayed.
The Weather Envoy beeps two times, also occurring within one second of 
each other. 

8. Check the Baud Rate setting on the console. The default value for the Baud 
Rate setting is 19200.

Note: If you have a Weather Envoy, do not change this Baud Rate value in the WeatherLink 
software. The Baud Rate setting on the console or on the Weather Envoy (always 19200) 
must be set the same as the WeatherLink Baud Rate setting. See the WeatherLink Online 
Help for more information.

To display the Baud Rate settings on a console, make sure the data logger is 
installed and then continue using the following procedures:
• Enter the console Setup Mode by pressing and holding DONE, then press-

ing the down arrow (-). 
• Use the BAR and DONE to scroll to the Baud Rate settings screen: 

Use the up (+) and down (-) arrows to change the Baud Rate setting, if needed. 
Press and hold DONE to return the console to the current weather mode.
• Use the fastest Baud Rate your computer can handle. 19200 is the fastest 

Baud Rate available and is the default setting on the console.
• Press DONE when you have the correct Baud Rate on the console screen.

Note: The data logger does not require a constant connection with a computer to continue 
logging and storing data. Although the data logger should remain connected to the 
console at all times, the data logger needs to be connected to the computer only when 
data is being downloaded or when the computer is actively using data from the data 
logger. The data logger and console can be disconnected from the computer if the 
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WeatherLinkIP Hardware Installation
console is placed in a location where the data logger cable cannot reach. However, 
WeatherLink’s bulletin, summary, or other real-time window displays are accessible only if 
the console is attached to the computer. 

WeatherLinkIP Hardware Installation
Complete the WeatherLink IP hardware installation by using the instructions 
below:
1. Locate the console or Weather Envoy that will receive the WeatherLinkIP 

connection.
2. For consoles only: Enter the console’s Setup Mode by pressing and 

holding DONE, then pressing the down arrow (-). Entering Setup Mode 
ensures that the station is not writing any data and saves the current daily 
weather information to memory.

3. Remove the battery cover, the batteries, and AC-power adapter, if present.

Note: Failure to remove power to the console or Envoy before installing the data logger may 
cause damage to the data logger or console. Plugging or unplugging the data logger 
while power is applied can lock up or damage the data logger.

4. Firmly insert the WeatherLinkIP data logger into the large receptacle 
marked EXPANSION inside the battery compartment. 

5. Connect one end of the Ethernet cable to the WeatherLinkIP data logger.
6. Locate a free Ethernet port on your broadband or DSL router/hub and 

connect the cable to the port.
7. Reconnect the AC adapter and then reinsert the batteries.

Note: A console using a WeatherLinkIP data logger requires use of the AC-power adapter. 
Battery power can be used for short-term backup power in the event of a power outage, 
but a console or Envoy with WeatherLinkIP should use the AC-power adapter as its main 
source of power. 

The console beeps three times; each beep occurring within one second of 
the others. Once power has been returned to the console, the Setup Mode is 
automatically displayed.
The Weather Envoy beeps two times, also occurring within one second of 
each other. 

8. Check the Baud Rate setting on the console. The default value for the Baud 
Rate setting is 19200. This value is required when using WeatherLinkIP.

9. Write down the Device ID and Key located on the side of the 
WeatherLinkIP data logger for further use. 
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WeatherLinkIP Hardware Installation
The Device ID (DID) and Key uniquely identify your data logger on the 
WeatherLink Network (www.weatherlink.com). They are both required to 
create a login on WeatherLink.com and are used to connect the 
WeatherLinkIP data logger to the software.

Note: Because WeatherLink IP is continuously uploading current weather information to the 
www.weatherlink.com, leave the WeatherLinkIP and console connected to your router at 
all times.

WeatherLinkIP and Weatherlink.com
The WeatherLinkIP data logger provides you with the same archiving features 
as a serial or USB data logger but also automatically uploads your Vantage Pro 
or Vantage Pro2 console or Envoy information to a web server provided by 
Davis Instruments that lets you see your weather data via the internet without 
having to set up your own web page. In addition, your weather data is 
automatically saved to our web servers which provide four times the memory 
storage of a data logger. 

Vantage Pro or
Pro2 Console

Battery Cover

Cable

Router

WeatherLink IP
Data Logger

WeatherLinkIP
Data Logger
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Serial Port Hardware Installation
Once you have connected the WeatherLinkIP data logger to your broadband 
router or switch, the data logger starts uploading your current weather 
information to the web server. To access your weather information over the 
internet:
1. Go to www.weatherlink.com
2. Read the license agreement and register your account using the Device ID 

and Key information provided on the data logger.
3. Create your account.
4. View your current weather data on the web. 

Serial Port Hardware Installation
A serial port connection can be installed so that WeatherLink uses a direct, 
local connection between the computer and console, or so that WeatherLink 
uses a modem connection to a remote weather station. Installation for each 
connection type differs, and is explained separately below.
Local Connection Installation
1. Find the weather station console that will receive the WeatherLink serial 

connection.
2. For consoles only: Enter the console’s Setup Mode by pressing and hold-

ing DONE, then pressing the down arrow (-) key. Entering Setup Mode 
ensures that the station is not writing any data and saves current daily 
weather information to memory.

3. Remove the battery cover and remove the batteries and AC-power adapter, 
if present.

Note: Failure to remove power to the console or Weather Envoy before installing the data log-
ger may cause damage to the data logger or console. Plugging or unplugging the data 
logger while power is applied can lock up or damage the logger.
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Serial Port Hardware Installation
4. Firmly insert the data logger with serial connector into the receptacle 
marked EXPANSION inside the battery compartment. 

5. Guide the data logger cable through the square slot below the receptacle.
6. Reconnect the AC adapter, if present, and then reinsert the batteries. 

The console beeps three times; each beep occurring within one second of 
the others. Once power has been returned to the console, the Setup Mode is 
automatically displayed.
The Weather Envoy beeps two times, also occurring within one second of 
each other. 

7. Replace the battery cover so that the data logger cable exits through the 
square slot.

8. Locate a free serial port on the back of the computer and connect the DB-9 
pin connector to the port.

9. Insert the cable plug at the end of the short cable coming from the data log-
ger into the receptacle on the end of the 8' cable. Then insert the cable plug 
on the end of the 8' cable into the DB-9 connector.
The cable connecting the data logger to the computer is 8' (2.4 m) long. 
Use a 40' (12 m) straight-through 4-conductor extension cable to extend 
the connection between the console and computer. Do not attempt to use 
more than 40' of extension cable, or the data logger may have difficulty 
communicating with the computer. 

Vantage Pro or Pro2 console

data logger

8' (2.5 m)
data logger

cable 

COM Ports

Optional 40' (12 m) 4-Conductor
 Extension Cable and Coupler

Connection
Options

(DB-9)
9-pin connector battery cover

Connecting your Computer Directly to your Weather Station
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Serial Port Hardware Installation
Configure the console so that data is transferred between the console data 
logger and the computer at the same rate.

10. Check the Baud Rate settings on the console. 

Note: If you have a Weather Envoy, do not change this Baud Rate value in the WeatherLink 
software. The Baud Rate setting on the console or on the Weather Envoy (always 19200) 
must be set the same as the WeatherLink Baud Rate setting. See the WeatherLink online 
help for more information.

To display the Baud Rate settings on a console, make sure the data logger is 
installed and then continue using the following procedure:
• Enter the console Setup Mode by pressing and holding DONE, then press-

ing the down arrow (-). 
• Press BAR to scroll to the Baud Rate settings screen: 

Use the up (+) and down (-) arrows to change the Baud Rate setting, if needed. 
Press and hold DONE to return the console to the current weather mode.
• Use the fastest Baud Rate your computer can handle. 19200 is the fastest 

Baud Rate available and is the default setting on the console.
• Press DONE when the correct Baud Rate displays on the console screen.

Note: The data logger does not require a constant connection with a computer to continue log-
ging and storing data. Although the data logger should remain connected to the console 
at all times, the data logger needs to be connected to the computer only when data is 
being downloaded or when the computer is actively using data from the data logger. The 
data logger and console can be disconnected from the computer if the console is placed 
in a location where the data logger cable cannot reach. However, WeatherLink’s bulletin, 
summary, or other real-time window displays are accessible only if the console is 
attached to the computer. 

Remote Modem Installation
Use a remote modem installation to connect your computer to a remote 
console or Weather Envoy. A remote modem installation is a connection from 
12



Serial Port Hardware Installation
the data logger on the console or Weather Envoy to a modem that can be 
dialed and accessed from a computer.

Using Modems to Connect Your Computer and Weather Station

Note: Before installing the console and modem at a remote location, test the data logger and 
connection first using a direct connection like that shown in the section above.

1. Install and set up an internal or external modem (according to the 
instructions supplied by the manufacturer) for use with your computer. 
Make a note of the COM port used by the modem. This information is used 
when using the Communications Port dialog box to connect to a console 
or Envoy.

2. At the station console site, put the external modem in a location where it 
can connect to both the logger and a phone jack and plug it into the jack.

Note: Do not turn the modem on at this time.

The cable connecting the data logger to the modem is 8' (2.4 m) long. If 
necessary, use a 40' (12 m) standard 4-conductor extension cable to extend 
the connection between the console and modem. Do not attempt to use 
more than 40' of extension cable, or the data logger may have difficulty 
communicating with the computer. 

3. Plug the external modem into the phone jack.
4. For consoles only: Enter the console’s Setup Mode by pressing and 

holding DONE, then pressing the down arrow (-). Entering Setup Mode 
ensures that the station is not writing any data and saves the current daily 
weather information to memory.

5. Remove the battery cover from the console back and remove all power by 
removing the batteries and AC power adapter, if present.

Vantage Pro or Pro2 console

battery cover

8' (2.5 m)

data logger

cable 

data logger
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Serial Port Hardware Installation
Note: Failure to remove power to the console before installing the data logger may cause dam-
age to the data logger or console. Plugging or unplugging the data logger while power is 
applied can damage or lock up the data logger.

6. Firmly insert the serial data logger into the receptacle marked 
EXPANSION inside the battery compartment. 

7. Guide the data logger cable through the square slot below the receptacle.
8. Connect the Telephone Modem Adapter to the external modem.

Note: Do not use a DB-25 adapter (not included) and a gender changer to attach the logger to a 
modem. It will not work. 

9. Insert the cable plug at the end of the cable into the Telephone Modem 
Adapter.

10. Turn the modem ON. Turning the modem on at this point allows it to 
receive the modem initialization string from the console.

11. Restore power to the console or Envoy by reinstalling the batteries and 
reattaching the power adapter, if present.
The console beeps three times; each beep occurring within one second of 
the others. Once power has been returned to the console, the Setup Mode is 
automatically displayed.
The Weather Envoy beeps two times, also occurring within one second of 
each other. 

12. Replace the battery cover, so that the data logger cable exits through the 
square slot.

13. Check the Baud Rate settings on the console. Press BAR to scroll to the 
Baud Rate settings screen, shown on the following page:

Note: The default value for the Baud Rate setting is 19200. If you have a Weather Envoy, this 
value should remain the same in the WeatherLink software. The Baud Rate settings 
screen displays only if the data logger has been installed. 
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Remote Modem Connection Notes
The Baud Rate setting on the console must be same as that set in the 
WeatherLink software. Use the up (+) and down arrows (-) to change the Baud 
Rate setting, if needed. Press and hold DONE to return the console to the 
current weather mode.
• Use the fastest Baud Rate your modem can handle. 19200 is the fastest 

Baud Rate available and is the default setting on the console.
• Press DONE when the correct Baud Rate displays on the console screen.

Pressing DONE in this screen sends the initialization string to the modem, 
so you don’t have to turn the console on and off again.

Remote Modem Connection Notes
When accessing a remote modem connection, WeatherLink automatically 
dials the station and console whenever an action has been performed in the 
software that requires it to talk to the station.
While connected to a remote station, an On-Line icon displays in the tool bar. 
This icon indicates that WeatherLink has established a connection with the 
remote console and weather station. 
To disconnect the phone connection, select the On-Line icon from the tool bar 
or select Hang Up from the File menu.

Toolbar with On-Line Icon
By default, WeatherLink disconnects from the modem after one minute 
without any communication with the station. Use the Communications Port 
dialog box in the Setup menu of WeatherLink to change this default value. 
(See the WeatherLink Online Help for more information.) 

Note: WeatherLink does not hang up the phone line if the bulletin, summary, or other windows 
receiving real-time data from the console are active. 

Software Setup
It is easy to set up WeatherLink on your computer once the connection to your 
console has been configured. Walk through the following procedures to setup 
and configure your WeatherLink software and the connection to your console. 

Online

(Hang Up)
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Running the Software
Running the Software
To run the software, double-click the WeatherLink icon. If no stations have 
been assigned in the program directory, the software prompts you to add a sta-
tion (see below for details). 
If this is a software upgrade and if there is more than one station in the 
program directory when the application opens, the last station that was 
displayed is automatically opened.

Station Setup
Each station connected to the computer must have its own station within the 
software. The software creates a database for the station and other station-
specific information, and requires the necessary communication settings 
(communication type, etc) be provided.
Adding a Station
1. Select New Station from the File menu. The New Station dialog box 

displays.
2. Type the desired station name (up to 40 characters/spaces) into the Station 

Name text box. The software uses the first eight characters of the station 
name (not counting spaces or punctuation marks) as the name of the direc-
tory where it saves this station’s database and configuration files. The first 
eight characters of each station name must, therefore, be unique. 

3. Click OK to save the new station or click Cancel to exit without saving.
The software saves the new station, creates a directory and a configuration 
file for the station, and prompts you to enter the walk-through procedure. 

About the Walkthrough
The software includes a station setup walkthrough that steps you through the 
weather station configuration procedures. After adding a new station, the 
Walkthrough dialog box automatically displays. By selecting Yes, the 
walkthrough begins. By selecting No, the Walkthrough is cancelled. 
You can set up and configure your station by separately selecting all of the 
necessary setup options from the Setup menu. A Walkthrough option is 
included in the Setup menu that allows you to access the Walkthrough at any 
time.

Note: When necessary, the software automatically dials a phone modem station. 

By selecting the Walkthrough process, the software displays a series of dialog 
boxes. At each step in the Walkthrough process, confirmation boxes are pro-
vided to perform or skip the next step in the Walkthrough. To continue, select 
OK. To skip this step and move to the next step, select Skip. To cancel the 
entire walkthrough process, select Cancel.
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Communication Port Settings
Note: Please refer to the WeatherLink Online Help for more information about the complete 
Walkthrough process.

Communication Port Settings
WeatherLink contains a dialog box for configuring the communication settings 
for your serial, USB, WeatherLinkIP data logger, or modem configuration. 
Use the Communications Port dialog box to select the communications type 
and to test communication between the computer and the station.
1. Select Communications Port from the Setup menu or use the 

Walkthrough to display the dialog box. 
The Communications Port dialog box displays.
17



Communication Port Settings
2. Select your data logger’s communication type from the communications 
field. The sections of the dialog box that pertain to the selected 
communication type become active. 
Provided below is an overview for connecting the Serial, USB and 
WeatherLink communications type in the Communications Port dialog 
box. Review the instructions for your selected communications type. See 
the WeatherLink Online Help for more detailed instructions. Also, see the 
WeatherLink Online Help for complete instructions for your modem 
connection.

For Serial Communication
1. Select Serial from the communications field. 
2. Select the communications port that connects the data logger to the 

computer from the Com Port drop-down list box or click Auto-Detect to 
to find and select the correct COM port being used for your serial port 
connection.

3. Select the rate at which the console or Envoy connects to the computer 
from the Baud Rate drop-down list box. Leave the Baud Rate at 19200.

4. Click Test to verify communication. 
5. Click OK to save the Communications Port settings.
For USB Communication

Note: If you have a USB data logger that you would like to emulate a serial port connection (for 
third-party applications), select Serial. If you have a USB data logger and want to set up a 
direct link between the USB data logger and the software, select USB. See the Weather-
Link Online Help for more information.

1. Select USB from the communications field. The USB Connection dialog 
box displays.

Note: Only one USB data logger should be connected when testing/setting up communications. 
If you have more than one USB station connected to the computer, the application 
associates with the first data logger it finds, so connect only the desired station to the 
computer during this process.
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Communication Port Settings
2. Click OK if one USB data logger is connected. The Serial-to-USB Mode 
dialog box displays when a USB data logger is connected for the first time. 
It won’t display if other USB data loggers are connected.

3. Click Test to verify communication. 
4. Click OK to save the Communications Port settings.
For WeatherLinkIP Communication
1. Select TCP/IP from the communications field. The areas you need to 

define for TCP/IP communication become active in the dialog box.
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Communication Port Settings
2. Select one of the three available radio buttons that best describes the type 
of TCP/IP connection you want to setup:

• Local Device ID — Connects to the WeatherLinkIP data logger through 
a Local Area Network connection. Use this option if your computer is 
connected to the same router or switch as your WeatherLinkIP data 
logger.

• Remote IP Address — Connects the WeatherLinkIP data logger and 
station to the WeatherLink Software through a remote connection using 
an IP address. This connection generally requires a static IP address.

Note: Note: This option is only used if your WeatherLink IP equipped console or Envoy is at a 
location on the internet that is remote from the location of the computer on which your are 
running your WeatherLink software. It is an advanced setup option. See the WeatherLink 
Online Help for more information.

• Web Download — Downloads data collected from a console or Envoy 
connected to a WeatherLinkIP data logger via www.weatherlink.com.

For a Local Connection:
1. Click Local Device ID.
2. Click Find to find the Device ID for the data logger.
3. Click Test to verify communication. 
4. Click OK to save the Communications Port settings.

For Web Download:
1. Click Web Download.
2. Enter the User ID and Password you created on www.weatherlink.com. 

See “WeatherLinkIP and Weatherlink.com” on page 9 for more 
information.

3. Click OK to save the web download settings.

Updating Previous Versions
Starting with Version 5.2, WeatherLink stores additional sensor data in the 
weather database. Data files from earlier releases do not contain the additional 
data and should be converted before use by the latest version of WeatherLink. 
The following procedure explains how to convert older WeatherLink data files 
for use with WeatherLink 5.2 and later versions. If you are updating from 
version 5.0 or 5.1, there are also instructions on how to retrieve additional 
existing data from your Vantage Pro data logger and incorporate it with your 
weather data files.
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Database Conversion
Database Conversion
If you have an existing weather database from WeatherLink 5.1 or earlier 
(including versions of WeatherLink 3 and 4), there are two ways to convert 
those files for use with versions of WeatherLink 5.2 or later.
Convert a WeatherLink Station (for 5.2 or later)

This method converts all the data files in an existing WeatherLink station 
directory and retains the previously entered station configuration data.
1. Install the new version of WeatherLink in a new program folder.
2. Copy the station folder from the previous WeatherLink program folder to a 

WeatherLink 5.2 or later program folder.
3. Use the Open Station command in the File Menu to open the copied station 

folder. WeatherLink automatically detects that the station was created by a 
previous version of the software and asks to convert the data and station.

4. Click OK to convert the station configuration, including weather database 
files. WeatherLink automatically creates a backup copy of the old files and 
then converts them for use by versions of WeatherLink 5.2 or later. 

Import Database Files (for 5.1 or earlier)

The Import Database Files menu option allows you to select individual files or 
groups of files to be converted for use by WeatherLink 5.2 or later.

Note: WeatherLink does not import database files created by versions of WeatherLink 5.2 or 
later using the Import Database File option. The Import Database Files option imports 
only database files created by WeatherLink version 5.1 or earlier.

1. Open WeatherLink 5.2 or later and select Import Database Files from the 
File menu. The Browse dialog box displays.

2. Select the data files you want to import. Select one file or multiple files in 
the same folder.

3. Click Open to convert the selected files. These files are put into a subdi-
rectory called "Converted Database Files".

4. Copy the converted files to your station directory.
5. Reopen the station in WeatherLink to view the converted files.
Retrieving Data From the Data Logger
The data loggers for Vantage Pro, Vantage Pro2, and Weather Envoy contain 
data and weather variables that were not used by WeatherLink 5.0 or 5.1, such 
as UV, solar radiation, rain rate, and ET (evapotranspiration). Versions of 
WeatherLink 5.2 or later allow you to view and use these variables that earlier 
versions did not. Depending on the archive interval used on your data logger, 
up to 200 days of this data which you can retrieve and incorporate into a ver-
sion of WeatherLink 5.2 or later, may be stored on the data logger. 
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Database Conversion
To incorporate this data into WeatherLink 5.2 or later data files:
1. Select New Station in the File menu and create a temporary weather 

station folder. (See Adding a New Station for more information)
2. Select Download in the File menu or click on the Download icon. 

WeatherLink does a full download of all data stored in the data logger. 
3. Select Browse in the Window menu or click on the Browse icon.
4. Scroll to the beginning of the data file, and write down the time and date of 

the first entry in the database.
5. Open the original WeatherLink station using the Open Station option in the 

File menu.
6. Select Browse from the Window menu or click on the Browse icon.
7. Select Delete Records in the Browse Menu.
8. Select records for the days following the earliest date in the temporary 

station database. 

Note: Do not select the records for the day the temporary database begins. Each record can be 
deleted individually for that day in the next step.

9. Individually select and delete each record in the database dated after the 
earliest record in your temporary database from the Browse Window.

Note: WeatherLink downloads data only for dates and times not already in the database. Delet-
ing records allows it to download new data.

10. Select Download in the File menu or click on the Download icon to down-
load data from the data logger.

11. Select Delete Station in the File menu and select the temporary station you 
created in Step 1 to delete it from the list of stations currently in use.

Recalculate THSW Index
WeatherLink 5.3 and later support a new derived data parameter, the Tempera-
ture Humidity Sun Wind (THSW) Index. If your station contains a solar radia-
tion sensor, this value can be calculated for existing data by selecting 
Recalculate THSW Index in the Browse Menu, which is displayed when the 
Browse window is open.

Note: Be sure to verify that the latitude and longitude settings and daylight savings time settings 
are correct before using this command.

Troubleshooting Guide
The following section answers some of the most commonly asked questions 
about WeatherLink. Please consult this guide and the online help files before 
contacting Technical Support. 
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Communications Problems
Communications Problems
If you are having trouble establishing communication between the weather 
station and WeatherLink, start by checking the console's own diagnostics. 
Remove all power to the console and restart it by restoring power (with the 
data logger still attached). 

Note: The data logger uses nonvolatile memory, so any previously recorded data is still stored. 
However, put the console in Setup Mode (by pressing and holding DONE, then pressing 
the down arrow(-)) before removing power, so that no damage to the data logger occurs.

• Three beeps sound from the console, each of which occurs when the 
weather station passes one of its diagnostic tests. Each beep follows the 
previous after about one second. The first beep notes that the processor is 
running. The second beep emits when the data logger is detected (if 
installed) and the third beeps for the display. 
If using a Weather Envoy, two beeps emit when it passes the first two diag-
nostic tests.

Note: If you do not hear one or more of these beeps, contact Davis Instruments. Only two 
beeps emit if the data logger is not installed.

• If the console sends three beeps or the Weather Envoy sends two beeps, See 
“Communication Port Settings” on page 17 for instructions on checking 
communication settings.

Troubleshooting Serial Port Communication
•  If the port settings or the loop back test process identifies a serial port other 

than the one selected in station setup, try connecting to the data logger 
again.

• Check the serial port adapter if using a serial port connection. Use only the 
blue serial port adapter supplied with WeatherLink. Older models, or mod-
els not supplied in the WeatherLink connection kit, are not compatible.

• Check the Baud Rate setting on the console and in the Communication 
Port dialog box in the software. Make sure they have the same number. 
Enter the console’s Setup Mode by pressing and holding DONE and then 
pressing the down arrow (-) on the console. 

• Scroll through the setup choices by pressing BAR until you reach the Baud 
Rate screen. This screen appears only if the data logger is plugged into the 
console.
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Communications Problems
• Test the serial port using the provided loopback connector. Use the Loop-
back button (as opposed to the Test button) in the Communications Port 
dialog box to test and find the correct serial port connection. If a communi-
cations problem exists, it determines whether the serial port or the data log-
ger is not communicating properly. The loopback function also detects and 
reports the presence of any modems.
Use the loopback connector (the short cable with a 
phone jack on one end and a red plastic tip on the 
other) supplied with a WeatherLink serial port con-
nection package. 

1. If necessary, disconnect the cable between your 
console and the adapter connected to the COM port.

2. Insert the loopback connector into the adapter.
3. Select Communications Port from the Setup menu. The Communications 

Port dialog box displays.

Loopback
connector
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Communications Problems
4. Click Loopback.
The software searches all standard ports and displays the COM port 
number where the loopback connector is located.

The correct COM port is automatically selected in the Communications 
Port dialog box. If the loopback connector is not found on any COM port, 
your serial port may not be working. If a connection still does not exist or 
if the loopback test identifies the same serial port you have selected, 
eliminate the following possibilities:

Note: Contact your PC vendor or technical support for more information on these device 
difficulties.

• Hardware device conflict—Check the Device Manager tab in the 
Windows System Properties dialog box to ensure that Windows 
recognizes the selected COM port. Consult your computer’s 
documentation to see how to access the System Properties dialog box.

• The communication port uses a nonstandard device 
name—WeatherLink recognizes serial ports named COM1 through 
COM18 only. To use a modem, specify the underlying COM port on 
your PC. To find out which port the modem’s connected to, display 
Windows’ System Properties > Device Manager > “modem name” 
Properties > Modem > Port, and check the listed “modem name” is the 
modem name you installed.

• Your serial port is defective.
• The loopback connector or the WeatherLink adapter plug is bad.

Note: See the WeatherLink Online Help if you are troubleshooting a Modem connection.

Troubleshooting USB Communication
• Close the WeatherLink software.
• Disconnect the USB cable from the console or Envoy. 
• Plug the cable back into the console or Envoy.
• Open the WeatherLink software again.
• Open the Communications Port dialog box. Select USB if USB is not 

selected in the communications field and follow the prompts.
• Click Test to verify communication between the station and the software. 
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Communications Problems
If the test is unsuccessful, either the station is malfunctioning or the drivers 
for communicating with USB have not been installed successfully. To 
verify that the driver is installed, look in Windows’ System Properties -> 
Device Manager -> Universal Serial Bus Controllers and see if the 
USBXpress Device is listed. If the driver is listed and there is still no 
communication between the station and the computer, call Technical 
support. If the drivers are not listed, contact Technical Support for 
instructions on installing the necessary drivers.

• If you are using a third party application that requires the USB connection 
to emulate a com port connection, see WeatherLink Online Help for more 
information or Contact Technical Support.

Troubleshooting WeatherLinkIP Communication

Note: A console using a WeatherLinkIP data logger requires use of the AC-power adapter. 
Battery power can be used for short-term backup power in the event of a power outage, 
but a console or Envoy with WeatherLinkIP should use the AC-power adapter as its main 
source of power. 

1. See if you have a connection to the internet established. Verify that you can 
access a website from a computer connected to the router or switch that the 
WeatherLinkIP data logger is using.

2. Check the cable connection between your WeatherLinkIP data logger and 
the broadband router or switch. Check if the green light on the 
WeatherLink IP data logger is on.

3. Leaving the data logger connected to your router, disconnect power from 
both your router and your console or Envoy.

4. Return power to the router or switch. Wait for at least one minute as the 
router reboots and re-establishes connections.

5. Return AC power to the console or Envoy.
6. Check if the green light on the WeatherLink IP data logger is on. If it is not 

on, contact Technical Support.
7. For Consoles Only - Hold down the DONE key to exit the Setup Mode.
8. For Weatherlink.com - Wait five minutes. Go to www.weatherlink.com 

and register the WeatherLinkIP data logger using the Device ID and Key. 
If you have already registered, check that your My Weather page is cur-
rently being updated.

9. For WeatherLink Software - Open WeatherLink. Open the 
Communications Port dialog box. Select TCP/IP if TCP/IP mode is not 
already selected. Select the communications type under TCP/IP you wish 
to use.
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Program Problems
For Local Connections Only
•  In the Communications Port dialog box, select Local Device ID and 

click Find. If the data logger is communicating on the network, the 
Communications Settings dialog box displays the Device ID and IP 
address of your data logger. If the dialog box does not display, check 
connections and try again or contact Technical Support.

• Click Test to verify communication between the station and the software. 

For Web Download Only 
• In the Communications Port dialog box, verify that the User ID and 

Password are the same User ID and Password you used when you created 
your web account on www.weatherlink.com.

Program Problems
The barometer graph on the Bulletin does not “fill in” completely. 

When you first load the bulletin, the barometer graph will only fill in com-
pletely when you have data in your database for the last six hours. Make sure 
of the following:
• There is data in your database for the span of the barometer graph.
• The time and date of the stored barometer data is correct in your database.
• The time and date on the PC is correct.
• The time and date on the weather station are correct.
• In the Station Configuration dialog box, set the Download archive data 

when Bulletin or Summary is started drop-down box to Always or to 
Confirm each time.

No wind direction reading (or dashes instead of a reading) appears in my database.
Be aware that if there is no wind speed when the direction is being sampled, 
wind direction is not recorded. During intervals with very little wind speed, no 
direction may be recorded. 

Note: Because high wind speed is sampled more often, it is possible to have a high wind speed 
but no wind speed or direction.

WeatherLink says “No new data to download” but I know there’s data there. What can 
I do?

The Vantage Pro2 system is smart enough to send only data it hasn’t already 
sent to the computer. So, when you initiate a new download, the program will 
retrieve the first record after the last record shown in the WeatherLink’s 
Browse Window. Older data may still be in the data logger, if you have not 
cleared its memory. To see how many of these older records are stored in the 
logger, create a new station and download the data into this new database. 
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Program Problems
Because there are no records stored in the station you just created, 
WeatherLink will download everything it has stored.
Next, try clearing the archive memory using the clear dialog box. You will lose 
any data not already downloaded in your archive memory, but all of your cali-
bration numbers and alarm settings will remain intact. If this doesn’t work, 
reboot your weather station (that is, remove and then restore all power to the 
station). 

Note: Make sure to put the console in Setup Mode (by pressing the DONE and DOWN arrow 
keys) before removing the batteries. The ensures the station will remember the current 
daily high and low values and the daily rain and ET accumulation.

When viewing data, dashes appear in place of a value for functions other than wind 
direction. Why?

If no data was recorded by a sensor (for example, the sensor was disconnected 
or radio interference blocked reception), or if bad data was recorded for a 
sensor (for example, the sensor was malfunctioning), the software dashes out 
the entry rather than showing invalid data. You can use the record editor to 
correct these entries.

The data I want to see, such as solar radiation, soil moisture, or Temp 2 does not dis-
play. Why?

All optional sensors must be enabled in the Station Configuration dialog box 
before the data will be displayed in WeatherLink. If you are not seeing data 
from a sensor that is installed in your weather station, be sure check the 
Station Configuration in the Setup Menu and make sure the sensor has been 
selected. 
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Contacting Davis Technical Support
Contacting Davis Technical Support
If you have questions about the software, or encounter problems installing or 
using the software, please contact Davis Technical Support. Most questions 
can be answered on the phone. 

Note: Sorry, we are unable to accept collect calls. 

Phone Support:
(510) 732-7814 – Monday – Friday, 7:00 a.m. – 5:30 p.m. Pacific Time. 
(510) 670-0589 – Technical Support Fax
E-mail Support:
support@davisnet.com – Technical Support e-mail.
info@davisnet.com – General e-mail. 
www.davisnet.com – Davis Instruments’ website. Includes Weather support 
information.
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	Software Installation
	1. Place the WeatherLink software CD in your CD ROM drive.
	2. Click Accept to install the necessary components.
	3. Review the license agreement, click I agree and click Next. The Choose Destination Location dialog box displays.
	4. Select the default location to install WeatherLink or find another location by clicking Browse.
	Note: If you are upgrading your software from a previous version, click Browse to search for the directory or folder of the previous version of WeatherLink.
	5. Click Next once you have selected a location. The Confirm Installation dialog box displays.
	6. Click Next to start the installation. The Installing WeatherLink dialog box displays the installation progress. The Installation Successful dialog box displays once the software installation has been completed.

	Note: During the installation process, the USBXPress Device Driver and the Bridge Driver, two drivers required for USB connections are installed automatically.
	7. Click OK. WeatherLink has been installed successfully.


	USB Hardware Installation
	1. Locate the console or Weather Envoy that will receive the WeatherLink USB connection.
	2. For consoles only: Enter the console’s Setup Mode by pressing and holding DONE, then pressing the down arrow (-). Entering Setup Mode ensures that the station is not writing any data and saves the current daily weather information to memory.
	3. Remove the battery cover, the batteries, and AC-power adapter, if present.
	Note: Failure to remove power to the console or Envoy before installing the data logger may cause damage to the data logger or console. Plugging or unplugging the data logger while power is applied can lock up or damage the data logger.
	4. Firmly insert the USB data logger into the large receptacle marked EXPANSION inside the battery compartment.
	5. Locate a free USB port on your computer and connect the USB connector to the port.
	6. Insert the USB - Mini B connector on the USB connector of the USB data logger. The connection between the console and the computer can be extended up to 16' (5 m) using a USB-to-USB connector cable.

	Note: Do not attempt to use more than a 16' extension cable, or the data logger may have difficulty communicating with the computer.
	7. Reconnect the AC adapter, if present and then reinsert the batteries.
	8. Check the Baud Rate setting on the console. The default value for the Baud Rate setting is 19200.

	Note: If you have a Weather Envoy, do not change this Baud Rate value in the WeatherLink software. The Baud Rate setting on the console or on the Weather Envoy (always 19200) must be set the same as the WeatherLink Baud Rate setting. See the WeatherL...
	Note: The data logger does not require a constant connection with a computer to continue logging and storing data. Although the data logger should remain connected to the console at all times, the data logger needs to be connected to the computer onl...

	WeatherLinkIP Hardware Installation
	1. Locate the console or Weather Envoy that will receive the WeatherLinkIP connection.
	2. For consoles only: Enter the console’s Setup Mode by pressing and holding DONE, then pressing the down arrow (-). Entering Setup Mode ensures that the station is not writing any data and saves the current daily weather information to memory.
	3. Remove the battery cover, the batteries, and AC-power adapter, if present.
	Note: Failure to remove power to the console or Envoy before installing the data logger may cause damage to the data logger or console. Plugging or unplugging the data logger while power is applied can lock up or damage the data logger.
	4. Firmly insert the WeatherLinkIP data logger into the large receptacle marked EXPANSION inside the battery compartment.
	5. Connect one end of the Ethernet cable to the WeatherLinkIP data logger.
	6. Locate a free Ethernet port on your broadband or DSL router/hub and connect the cable to the port.
	7. Reconnect the AC adapter and then reinsert the batteries.

	Note: A console using a WeatherLinkIP data logger requires use of the AC-power adapter. Battery power can be used for short-term backup power in the event of a power outage, but a console or Envoy with WeatherLinkIP should use the AC-power adapter as...
	8. Check the Baud Rate setting on the console. The default value for the Baud Rate setting is 19200. This value is required when using WeatherLinkIP.
	9. Write down the Device ID and Key located on the side of the WeatherLinkIP data logger for further use.

	Note: Because WeatherLink IP is continuously uploading current weather information to the www.weatherlink.com, leave the WeatherLinkIP and console connected to your router at all times.
	WeatherLinkIP and Weatherlink.com
	1. Go to www.weatherlink.com
	2. Read the license agreement and register your account using the Device ID and Key information provided on the data logger.
	3. Create your account.
	4. View your current weather data on the web.



	Serial Port Hardware Installation
	Local Connection Installation
	1. Find the weather station console that will receive the WeatherLink serial connection.
	2. For consoles only: Enter the console’s Setup Mode by pressing and holding DONE, then pressing the down arrow (-) key. Entering Setup Mode ensures that the station is not writing any data and saves current daily weather information to memory.
	3. Remove the battery cover and remove the batteries and AC-power adapter, if present.

	Note: Failure to remove power to the console or Weather Envoy before installing the data logger may cause damage to the data logger or console. Plugging or unplugging the data logger while power is applied can lock up or damage the logger.
	4. Firmly insert the data logger with serial connector into the receptacle marked EXPANSION inside the battery compartment.
	Connecting your Computer Directly to your Weather Station
	5. Guide the data logger cable through the square slot below the receptacle.
	6. Reconnect the AC adapter, if present, and then reinsert the batteries.
	7. Replace the battery cover so that the data logger cable exits through the square slot.
	8. Locate a free serial port on the back of the computer and connect the DB-9 pin connector to the port.
	9. Insert the cable plug at the end of the short cable coming from the data logger into the receptacle on the end of the 8' cable. Then insert the cable plug on the end of the 8' cable into the DB-9 connector.
	10. Check the Baud Rate settings on the console.


	Note: If you have a Weather Envoy, do not change this Baud Rate value in the WeatherLink software. The Baud Rate setting on the console or on the Weather Envoy (always 19200) must be set the same as the WeatherLink Baud Rate setting. See the WeatherL...
	Note: The data logger does not require a constant connection with a computer to continue logging and storing data. Although the data logger should remain connected to the console at all times, the data logger needs to be connected to the computer onl...
	Remote Modem Installation
	Using Modems to Connect Your Computer and Weather Station

	Note: Before installing the console and modem at a remote location, test the data logger and connection first using a direct connection like that shown in the section above.
	1. Install and set up an internal or external modem (according to the instructions supplied by the manufacturer) for use with your computer. Make a note of the COM port used by the modem. This information is used when using the Communications Port di...
	2. At the station console site, put the external modem in a location where it can connect to both the logger and a phone jack and plug it into the jack.

	Note: Do not turn the modem on at this time.
	3. Plug the external modem into the phone jack.
	4. For consoles only: Enter the console’s Setup Mode by pressing and holding DONE, then pressing the down arrow (-). Entering Setup Mode ensures that the station is not writing any data and saves the current daily weather information to memory.
	5. Remove the battery cover from the console back and remove all power by removing the batteries and AC power adapter, if present.

	Note: Failure to remove power to the console before installing the data logger may cause damage to the data logger or console. Plugging or unplugging the data logger while power is applied can damage or lock up the data logger.
	6. Firmly insert the serial data logger into the receptacle marked EXPANSION inside the battery compartment.
	7. Guide the data logger cable through the square slot below the receptacle.
	8. Connect the Telephone Modem Adapter to the external modem.

	Note: Do not use a DB-25 adapter (not included) and a gender changer to attach the logger to a modem. It will not work.
	9. Insert the cable plug at the end of the cable into the Telephone Modem Adapter.
	10. Turn the modem ON. Turning the modem on at this point allows it to receive the modem initialization string from the console.
	11. Restore power to the console or Envoy by reinstalling the batteries and reattaching the power adapter, if present.
	12. Replace the battery cover, so that the data logger cable exits through the square slot.
	13. Check the Baud Rate settings on the console. Press BAR to scroll to the Baud Rate settings screen, shown on the following page:

	Note: The default value for the Baud Rate setting is 19200. If you have a Weather Envoy, this value should remain the same in the WeatherLink software. The Baud Rate settings screen displays only if the data logger has been installed.

	Remote Modem Connection Notes
	Toolbar with On-Line Icon
	Note: WeatherLink does not hang up the phone line if the bulletin, summary, or other windows receiving real-time data from the console are active.


	Software Setup
	Running the Software
	Station Setup
	Adding a Station
	1. Select New Station from the File menu. The New Station dialog box displays.
	2. Type the desired station name (up to 40 characters/spaces) into the Station Name text box. The software uses the first eight characters of the station name (not counting spaces or punctuation marks) as the name of the directory where it saves this...
	3. Click OK to save the new station or click Cancel to exit without saving.

	About the Walkthrough
	Note: When necessary, the software automatically dials a phone modem station.
	Note: Please refer to the WeatherLink Online Help for more information about the complete Walkthrough process.

	Communication Port Settings
	1. Select Communications Port from the Setup menu or use the Walkthrough to display the dialog box.
	2. Select your data logger’s communication type from the communications field. The sections of the dialog box that pertain to the selected communication type become active.
	For Serial Communication
	1. Select Serial from the communications field.
	2. Select the communications port that connects the data logger to the computer from the Com Port drop-down list box or click Auto-Detect to to find and select the correct COM port being used for your serial port connection.
	3. Select the rate at which the console or Envoy connects to the computer from the Baud Rate drop-down list box. Leave the Baud Rate at 19200.
	4. Click Test to verify communication.
	5. Click OK to save the Communications Port settings.

	For USB Communication
	Note: If you have a USB data logger that you would like to emulate a serial port connection (for third-party applications), select Serial. If you have a USB data logger and want to set up a direct link between the USB data logger and the software, se...
	1. Select USB from the communications field. The USB Connection dialog box displays.

	Note: Only one USB data logger should be connected when testing/setting up communications. If you have more than one USB station connected to the computer, the application associates with the first data logger it finds, so connect only the desired st...
	2. Click OK if one USB data logger is connected. The Serial-to-USB Mode dialog box displays when a USB data logger is connected for the first time. It won’t display if other USB data loggers are connected.
	3. Click Test to verify communication.
	4. Click OK to save the Communications Port settings.
	For WeatherLinkIP Communication
	1. Select TCP/IP from the communications field. The areas you need to define for TCP/IP communication become active in the dialog box.
	2. Select one of the three available radio buttons that best describes the type of TCP/IP connection you want to setup:


	Note: Note: This option is only used if your WeatherLink IP equipped console or Envoy is at a location on the internet that is remote from the location of the computer on which your are running your WeatherLink software. It is an advanced setup optio...
	For a Local Connection:
	1. Click Local Device ID.
	2. Click Find to find the Device ID for the data logger.
	3. Click Test to verify communication.
	4. Click OK to save the Communications Port settings.

	For Web Download:
	1. Click Web Download.
	2. Enter the User ID and Password you created on www.weatherlink.com. See “WeatherLinkIP and Weatherlink.com” on page 9 for more information.
	3. Click OK to save the web download settings.




	Updating Previous Versions
	Database Conversion
	Convert a WeatherLink Station (for 5.2 or later)
	1. Install the new version of WeatherLink in a new program folder.
	2. Copy the station folder from the previous WeatherLink program folder to a WeatherLink 5.2 or later program folder.
	3. Use the Open Station command in the File Menu to open the copied station folder. WeatherLink automatically detects that the station was created by a previous version of the software and asks to convert the data and station.
	4. Click OK to convert the station configuration, including weather database files. WeatherLink automatically creates a backup copy of the old files and then converts them for use by versions of WeatherLink 5.2 or later.

	Import Database Files (for 5.1 or earlier)
	Note: WeatherLink does not import database files created by versions of WeatherLink 5.2 or later using the Import Database File option. The Import Database Files option imports only database files created by WeatherLink version 5.1 or earlier.
	1. Open WeatherLink 5.2 or later and select Import Database Files from the File menu. The Browse dialog box displays.
	2. Select the data files you want to import. Select one file or multiple files in the same folder.
	3. Click Open to convert the selected files. These files are put into a subdirectory called "Converted Database Files".
	4. Copy the converted files to your station directory.
	5. Reopen the station in WeatherLink to view the converted files.
	Retrieving Data From the Data Logger
	1. Select New Station in the File menu and create a temporary weather station folder. (See Adding a New Station for more information)
	2. Select Download in the File menu or click on the Download icon. WeatherLink does a full download of all data stored in the data logger.
	3. Select Browse in the Window menu or click on the Browse icon.
	4. Scroll to the beginning of the data file, and write down the time and date of the first entry in the database.
	5. Open the original WeatherLink station using the Open Station option in the File menu.
	6. Select Browse from the Window menu or click on the Browse icon.
	7. Select Delete Records in the Browse Menu.
	8. Select records for the days following the earliest date in the temporary station database.


	Note: Do not select the records for the day the temporary database begins. Each record can be deleted individually for that day in the next step.
	9. Individually select and delete each record in the database dated after the earliest record in your temporary database from the Browse Window.

	Note: WeatherLink downloads data only for dates and times not already in the database. Deleting records allows it to download new data.
	10. Select Download in the File menu or click on the Download icon to download data from the data logger.
	11. Select Delete Station in the File menu and select the temporary station you created in Step 1 to delete it from the list of stations currently in use.
	Recalculate THSW Index

	Note: Be sure to verify that the latitude and longitude settings and daylight savings time settings are correct before using this command.


	Troubleshooting Guide
	Communications Problems
	Note: The data logger uses nonvolatile memory, so any previously recorded data is still stored. However, put the console in Setup Mode (by pressing and holding DONE, then pressing the down arrow(-)) before removing power, so that no damage to the dat...
	Note: If you do not hear one or more of these beeps, contact Davis Instruments. Only two beeps emit if the data logger is not installed.
	Troubleshooting Serial Port Communication
	Loopback connector
	1. If necessary, disconnect the cable between your console and the adapter connected to the COM port.
	2. Insert the loopback connector into the adapter.
	3. Select Communications Port from the Setup menu. The Communications Port dialog box displays.
	4. Click Loopback.


	Note: Contact your PC vendor or technical support for more information on these device difficulties.
	Note: See the WeatherLink Online Help if you are troubleshooting a Modem connection.
	Troubleshooting USB Communication
	Troubleshooting WeatherLinkIP Communication

	Note: A console using a WeatherLinkIP data logger requires use of the AC-power adapter. Battery power can be used for short-term backup power in the event of a power outage, but a console or Envoy with WeatherLinkIP should use the AC-power adapter as...
	1. See if you have a connection to the internet established. Verify that you can access a website from a computer connected to the router or switch that the WeatherLinkIP data logger is using.
	2. Check the cable connection between your WeatherLinkIP data logger and the broadband router or switch. Check if the green light on the WeatherLink IP data logger is on.
	3. Leaving the data logger connected to your router, disconnect power from both your router and your console or Envoy.
	4. Return power to the router or switch. Wait for at least one minute as the router reboots and re-establishes connections.
	5. Return AC power to the console or Envoy.
	6. Check if the green light on the WeatherLink IP data logger is on. If it is not on, contact Technical Support.
	7. For Consoles Only - Hold down the DONE key to exit the Setup Mode.
	8. For Weatherlink.com - Wait five minutes. Go to www.weatherlink.com and register the WeatherLinkIP data logger using the Device ID and Key. If you have already registered, check that your My Weather page is currently being updated.
	9. For WeatherLink Software - Open WeatherLink. Open the Communications Port dialog box. Select TCP/IP if TCP/IP mode is not already selected. Select the communications type under TCP/IP you wish to use.
	For Local Connections Only
	For Web Download Only


	Program Problems
	Note: Because high wind speed is sampled more often, it is possible to have a high wind speed but no wind speed or direction.
	Note: Make sure to put the console in Setup Mode (by pressing the DONE and DOWN arrow keys) before removing the batteries. The ensures the station will remember the current daily high and low values and the daily rain and ET accumulation.

	Contacting Davis Technical Support
	Note: Sorry, we are unable to accept collect calls.
	Phone Support:
	E-mail Support:
	Tool bar Icons
	Hot Keys
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